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Installation Instructions for PHMS

Installation Instructions for PHMS
PHMS is a server-client application. This means there is a server part and a
client part of the installation. The server will store the data and it only should be
installed in one location. You will use the client to input, fetch and interact with
the data. You will need to install this part on each computer you wish to have
access to the database. The client and the server parts may reside on the same
computer.
NOTE: Your access to the database will be determined by the network and any of
its components that lies between you (the client) and the server.
Server Requirements: Windows 2000, XP, 2003 Server
Client Requirements: Any version of Windows and a minimum 1152x864 screen
resolution.
The PostgreSQL database server is also available for UNIX and Linux. Mac OS X
is also available from third parties.
The client software is available for Linux and should be available for Mac OS X
soon.
If you cannot follow or do not understand these instructions, please get your IT
department to install and configure the database for you.

Contents
•
•
•
•

Prerequisites
Server Installation Instructions
Client Installation Instructions
Configuring Database Server for non-local connections
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Overview
The basic operation of PHMS is centered around
the server-client model as seen in Figure 1. To
paraphrase, the server is the data storage
mechanism. Data is not saved in files or in
"shared" folders - it is stored by the server. On the
other hand, the client is responsible for retrieving
a given set of data from the server and presenting
it to the operator in a human friendly way.
Multiple clients may interact with the data on the
server simultaneously.
The most important requirement is that the
database server be installed on one and only one
machine. You will not be able to share data if you
have more than one database server installed.
There is no requirement for the server and the
Figure 1: Basic Installation
client part to be installed on separate computers.
Actually, the most straight forward installation is
for the client and the server to reside on the same machine.
Secondly, there is no requirement that the server is installed on a computer
running special "server" version of Windows. Any regular computer will do. What
is recommended is that the database server is deployed on a machine with
redundant storage. For example, a RAID 1 hard drive configuration is a perfect
choice. It allows for hard drive failure without any downtime or data loss.
Finally, the is no requirement that the computer running the server is a
dedicated machine. On the contrary,
it would be wasteful to have a
dedicated machine if you already
have another computer that can do
the job. In a normal environment, the
database server will use very little
resources and thus if you already
have a file server with redundant
storage, it makes sense to also use
that computer as the PHMS database
server.
The only requirement that must be
satisfied for PHMS to work is that it
must be able to connect with the

Figure 2: More complication installation
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database server to retrieve data. There is no "local" or "remote" automagical
sense built-in to PHMS. If it cannot access the server, it cannot retrieve, edit, or
even login to the database. There is no requirement on how the connection is to
be made between PHMS and the database server. For example, Figure 2 shows a
little bit more complicated interface to PHMS than in Figure 1. There may be
multiple PHMS users, some connected to the database over wireless LAN or VPN
(Virtual Private Network) or even dial-up. The solution that would be ideal for
your center is beyond this short overview, but your IT department should be able
to provide you with a secure remote or local connection between PHMS and the
database server.
In conclusion, an ideas server will be,
•
•
•
•

secure - a computer with relatively good physical security (not a laptop). If
your server gets stolen, so does your entire patient database.
reliable - redundant storage should be used to minimize the chance of
downtime and data loss in case of hardware failure.
accessible - all computers running PHMS must be able to access this
server for their data.
backup - please, backup your data. Your server can blow up, crash, catch
on fire, corrupt its file system, etc. There is no excuse for not setting up an
automated backup. For more information see Setting up Automated
Backup.

The PHMS client is just an interface between you and the server. Protect the
server as that is where you data resides. On the other hand, PHMS client
software is 100% replaceable.
If you would like to have multiple PHMS clients installed on different computers
having access to the database server, the database server must have a static IP.
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Prerequisites
Before installation, you will need to have Microsoft Windows Installer 3.1 or later
installed. Client installations on Windows 98 and Me will require Installer version
2.0. Systems that do not have these prerequisites will either receive an error
message that the installer is too old, or the .msi files will not be recognized at all.
Windows 2000 and XP users can also get the latest version of the installer from
the Windows Update website.
Windows Version Download Site for MS Installer
98/Me
Microsoft Website
NT/2000/XP
Microsoft Website
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If you are unable to begin installation after starting the Windows Installer file
(.msi file) and you are running version of MS Windows older than XP then it
is likely that you need to update the Windows Installer before continuing.
Proceed to the prerequisite section to download and install the necessary
files from Microsoft.

Installing the Server
Database Server Installation Instructions
The server installation consists of installing the backend database server called
PostgreSQL. Checked and verified installation files may be downloaded from
http://www.galacticasoftware.com/postgresql
1. Download PostgreSQL installation zip file from
http://www.galacticasoftware.com/postgresql/postgresql_8.0.3.zip and save
it.
2. Extract the zip file into a temporary location. After successful installation,
you may delete all of these files as well as the zip file downloaded in Step 1
If you are installing on MS Windows 2000 or older, you will need a
compression utility to extract the zip file. If you do not have one installed,
we would recommend 7-zip. You may download version 4.23 from here.
3. Go to the location where you have extracted the files and click on the
postgresql-8.0.msi file.
4. This is the first window of the installation. Select the language for the
installation and click Start button.
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5. On the introduction screen that follows, click the Next button to proceed.
6. The following window will display the Installation Notes. You may read
them! The most important bit here is to install PostgreSQL on a computer
with a NTFS file system. All modern computers that came with preinstalled versions of Windows 2000 or XP will be running on an NTFS. Click
the Next button to proceed.
7. In this window as seen here, don't change anything. Just click the Next
button to proceed.
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8. Here, you do not need to change anything. Just hit the Next button.

A number of dialog boxes may appear about creating a user account. Just
–9–
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click OK to accept. When a random password is presented to you, you do
not need to write it down. You will never need to use it.
9. After the server account was setup, you are now ready to configure the
database server. The next step should look like the window here.

In this window, before continuing, you will need to specify a password you
will remember. You will need this password so don't forget it (If you do
forget it, there is a way to recover it. DO NOT reinstall PostgreSQL or you
may lose data that was already entered).
Another important thing to note here is the "Accept connections on all
address, not just localhost" checkbox. If you are only going to be using
PHMS on the computer where you are installing PostgreSQL, leave this
unchecked. If you plan to access the database from other computers (ie.
install the client on computers other then the server), make sure that you
check this checkbox.
After you entered the password, click Next button.
10.In the next window, make sure that PL/pgsql is selected (it should be by
default) and click the Next button.
11.In the contrib. modules window, leave the defaults and click the Next
button.
12.Click Next to start the installation.
13.After the installation is complete, you may click the Finish button to close
– 10 –
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the installer. Congratulations, you have now installed PostgreSQL database
server.

Database Initialization Instructions
After installing the database server, you need to create the empty database to
store the data.
1. Go to the folder where you have unpacked the zip file in the Database
Installation Instruction section.
2. Start InitializeDatabase.bat and follow the prompts.
Now you may go to the Installing the Client section to install your client
software.
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Installing the Client
This document is about installing or upgrading to version 1.1.14 or later. If you
are installing an older version (not recommended), the installation instructions
are here.
If you are unable to begin installation after starting the Windows Installer file
(.msi file) then it is likely that you need to update the Windows Installer
before continuing. Proceed to the prerequisite section to download and
install the necessary files from Microsoft.

The client needs to be installed on each and every computer that you wish to
access the database. To install or upgrade the latest version of PHMS, all you
need to do is,
1. Login as Administrator
2. Download the latest version of PHMS
3. Double click on the installer* and follow the prompts. It is recommended to
install PHMS in the default location.
If you do not specify the IP address of the computer hosting the database server,
local computer address (localhost) will be assumed. To change the IP address
after installation you may use the tool in Programs→PH Management System
to set the IP address.
On application's first execution after an upgrade, you may receive a warning that
the database structure will need to be upgraded as well. The application does
this automatically, but it is advisable to backup your database before allowing
PHMS to do such modifications.
If this is your initial installation of PHMS, please go on to the configuration
section of this documentation and read it carefully. The "out of the box"
installation is generally not ready to accept data until after it has been
configured for your site.
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Configuring Database Server for non-local
connections
The default configuration of PostgreSQL only allows you to connect from the
same machine that the server is running on. To configure the database allowing
you to connect from other computers, you will need to add the IP addresses of
such computers to the configuration file and then restart the database server.
1. Go to PostgreSQL 8.0→Configuration files→Edit pg_hba.conf. from
your Start menu.
2. At the bottom of the file, add line
host

phms

all

IPaddress/mask

md5

replacing IPaddress/mask with a CIDR notation IP addresses that will be
connection to the database. You may add more than one line, if required.
3. Save changes and exit notepad
4. Go to PostgreSQL 8.0→Configuration files→Edit postgresql.conf
from the Start menu.
5. Under "Connection Settings" make sure that the listen_addresses line
reads
listen_addresses = '*'

and is not commented out (no # at beginning of the line) as the default
settings is equivalent to listening on 127.0.0.1 socket.
6. Save changes and exit notepad
7. Go to PostgreSQL 8.0 group from Start menu and restart the PostgreSQL
service.
You should now be able to connect to the PostgreSQL database from all IP
addresses you have added to the pg_hba.conf file. You may add more than one
line in Step 3, as needed. The IPaddress/mask format is a normal CIDR notation.
For example,
•
•

123.123.123.123/32 - will add 123.123.123.123 IP address only
123.123.123.123/24 - will add 123.123.123.0-123.123.123.255 addresses

You will only be able to connect from the added IP addresses (or networks) only.
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Backup and Restore the Database
WARNING: The database server, PHMS and most of the software are trivial to
replace. Your data is not. Please, make sure you have a safe backup location.
Ideally, multiple backup locations are preferable to one, but any backup and
better than any. Don't play Russian Roulette with your data - backup daily.

Summary
1. Local backup (not recommended as sole backup method)
2. Local server backing up to Report file system
3. Remotely initiated backup
4. Restoring database from backup

Local backup
Local backup, by definition, is not very reliable. It will protect you from such
errors as bugs in the database software that result in corrupted database or a
user deleting 2 years worth of data. On the other hand, local backups are less
beneficial against catastrophic software failures (operating system corrupts the
file system) or hardware failures.
To set up a local database backup, all we need is access to the database without
a password. To accomplish this, we first need to alter the configuration file. On
the computer running the database server, go to Start→All
Programs→PostgreSQL 8.0→Configuration files→Edit pg_hba.conf. This
should bring up a text editor with the configuration file. Go to the end of such a
file and alter the line that reads,
host all all 127.0.0.1/32 md5
to read,
host all all 127.0.0.1/32 trust
The change from md5 to trust results in all connections from localhost, or
127.0.0.1, to be trusted. Now restart the PostgreSQL database service by going
to Start→All Programs→PostgreSQL 8.0→Reload configuration. You should
now be able to connect to the database using any account from the local
computer without using a password.
The second step is to create a backup directory on your hard drive. Go to C:\ and
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create a folder called backup. Now, download this local backup batch file and
save it in this directory. If you have installed PostgreSQL in a non-default
directory, you may need to change the paths in this batch file.
Finally, go to the Control Panel and setup a daily Scheduled Task to run the
backup batch file on daily basis.

Local Server to Remote System Backup
The local to remote system backup is the recommended method of saving your
data. Ideally, you do not want to have the remote backup machine in the same
room, building or even city to counteract some of the potential disasters that
could occur (fire, water, electrical spikes, etc). Of course, any machine physically
separated from the server may be used.
To configure backup to the remote machine, your will need to make sure that
users on the server machine can log into the database without a password. The
procedure for doing that is listed in the above section about Local backups.
The second step that is needed is to create a directory on the remote machine
where the backups are to be stored. This directory must be accessible over the
Windows Network to the server. Now, download this back file into that directory.
You will probably need to alter the backup path in this batch file if it is not
\\Remote Server\Backup. To do this, open the batch file using Notepad and
change the BACKUP_PATH accordingly.
Finally, just like with local backups, go to the control panel of the server and set
up a Scheduled Task to run the remote_backup.bat batch file on a daily basis.
Once a Scheduled Task is configured, verify that the command will actually
backup the database correctly.

Remotely Initiated Backup
Another possible type of backup is the remotely initiated backup. A remote
machine connects to the database server and backs up all of the databases onto
its own hard drive.
For this type of backup to be possible, the remote machine must have at least a
copy of the Command Line Tools installed. To install the command line tools,
follow the instruction for the Database Server with the exception that,
•

•

in Step 7, do not install the Database Server or the Database Drivers. You
only need the User Interfaces (more specifically, the psql user interface)
installed.
do not do any database initialization, etc.. as you are not installing the
database, just the client tools
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NOTE: Some of the steps in the installation instructions might not occur since
the database is not being installed.
After the command line tools are installed on the remote machine, create a
backup directory (for example, C:\Backup) and download the following batch file
and save it into that directory. You will then need to edit this file using Window's
Notepad to reflect the configuration of your database. More specifically, you at
least will need to change the REMOTE_DATABASE_SERVER setting to the IP address
of the database server
Thirdly, you will need to alter the configuration file of the database server to
allow connection from the remote backup machine without a password. You will
need to add a line at the end of the configuration file. If the IP address of the
remote backup machine is 123.123.123.123 then the access line should look like
host all all 123.123.123.123/32 trust
After the database configuration is changed, restart the service on the database
server and test if the backup works on the remote machine. If the backup
succeeds, you can configure a Scheduled Task to execute the backup batch file
every day.

Restoring Database From Backup
To restore the database from a given backup file, copy a backup file to a location
accessible by the database server. For the sake of this document, it is assumed
that the backup file will be called C:\backup.sql.
Install the database server as per the Database Server Installation Instruction.
DO NOT initialize the database server as the backup restore will perform this
function.
After a new database was installed, open the command line client from
Start→All Programs→PostgreSQL 8.0→Connect to template1. Once you
logged in to the database, on the prompt enter,
\i 'c:/backup.sql'
or whatever the backup file is called. A large number of lines should scroll by
indicating the progression of the restore process. After the restore is completed,
enter \q followed by Enter to exit the command line.
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WARNING: The backup file may contain and set the superuser's password. If
this happens, the restore will not complete due to permission errors. Thus
when restoring data from a backup file, either
1. install the new database and specify the same password for the postgres
user as before, or,
2. disable password authentication for the super user when accessing the
database from the same computer as the server.
To disable password authentication for the local computer (localhost), follow
the procedure listed on page 14 when setting up local backup.
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Tutorial
The aim of this tutorial is to allow you to understand the purpose of PHMS, to
use its basic functionality to enter data as well as to allow you to fetch basic
reports. Everyone using or planning to use PHMS should read this tutorial to
become familiar with the software. You should allow a few hours to read the
tutorial and become familiar with the software.
This tutorial is divided into four parts. The first part deals with basic concepts
behind the use of the database. Everyone must read and understand this section
to use the database successfully. The second deals with data entry and data
integrity checks included in the software. We will go through examples of data
entry and its various pitfalls. The third section is an overview of various available
reports with examples. In the final section, we conclude with cleanup of the
database such that other people may go through this tutorial.
•
•
•
•

Basic Concepts
Data Entry
Reports
Final Remarks and Cleanup

If you have any questions or comments regarding this tutorial, please contact
your email support address

Expected Problems
All expected error messages are listed in the Common Problems and Solutions
page of this manual.

Unexpected Problems
If you receive an unexpected error message (ie. not an expected error message),
copy it down exactly and email your technical support. We will attempt to assist
you.
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Basic Concepts
What is a Networked Relational SQL Database?
The data store of PHMS is PostgreSQL 8.0 networked relational SQL database.
This means that the database server must be installed in one and only one
location only (ie. on one computer). All of its database clients (a.k.a. PHMS
software) will access it through your network (LAN). It is not a file, or a
webpage, but a specialized application allowing multiple clients (PHMS) to
access the contents of the database through the network. Your IT department
should be able to install, configure and maintain your database server for you.
Since it is not possible for database servers to share data amongst each other, if
you do install the database server in more than one location, data entered on one
PHMS will not be accessible from another installation. If you do have more than
one database server installed, please contact your IT department to install the
software properly and tell them to read the overview of how the database works.

Configuration Data
All configuration data, except for the hospital id, is stored in the database. This
means when someone changes the configuration in installation of PHMS client
on one computer, the changes will be reflected on another computer. You may
have to restart PHMS for the changes to take effect.

Data Entry Methodology
There are three different data record types available for entry. These are,
•
•
•

Assessment/Followup
Vasodilator Challenge
6-minute Walk

While the purpose of the later two is self-explanatory, the Assessment/Followup
can stir up confusion as to which one to enter - a Followup or an Assessment. The
reason why they are written as Assessment/Followup instead of separately is
because they are essentially the same with the following exceptions.
•
•

Assessment holds more data than a Followup.
A Followup must come after an Assessment (for historic reasons)
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Sample data entry order for a given patient
For example, if you have data for a patient that only fits in an assessment, enter
an assessment. If the data does not need an assessment (eg. medication
adjustment or lung function tests) then enter a followup.

Basic fields
There are two basic fields that must be entered first, before anything else. These
are the study date and the patient ID.
The patient ID is a unique identifier associated with a given patient. It is
assigned to a patient by your institution. The format is set in the Preferences
window.
IMPORTANT: When entering data, always make sure you enter the Patient ID
first. Make sure that the Patient ID is accepted by the database which means
you should no longer be able to change it (ie. the field will become read-only).
If you made a mistake entering the Patient ID, click Cancel and re-enter the
record.
The study date is the date associated with a given record. For example, in 6-min
walk or vasodilator challenge, the study date is the date that the given test was
performed. For assessment or a followup, this probably should be the date of the
doctor's visit. This date is important to establish a trend to patient's results and
it is important it is entered correctly.
There is currently no easy way (and no way in PHMS) to change a given record's
Patient ID or Study Date field once entered. The simplest way is to reenter the
data for the affected record(s).
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Data Entry
Only one person may enter the data as part of this tutorial at a given time. The
entered records must be deleted as illustrated in the cleanup section for another
person to follow the tutorial.
There are four types of records that are represented in this software. They are:
•
•
•
•
•

6-minute walk
Assessment
Follow-up
Vasodilator Challenge
Editing Previously Entered Data

In ALL cases, when entering data, you must enter Study Date and Patient ID
first. The Patient ID must be "locked" (ie. the field is "locked" when you cannot
modify it anymore - it is read-only). This only occurs when Patient ID is of the
correct format as configured for your site in the configuration.
When the Patient ID field is "locked", the patient's demographic data (as well as
medication as of the study date and few other fields, if applicable) are loaded if a
given Patient ID was already entered before.
We will start this tutorial by entering a basic 6-min walk test and then progress
to other types of records. Please read them in order since we will build on the
ideas from the previous examples.

6-minute Walk
Start the program and log-in. You should see the main window. Now go to
Patients → 6-min Walk → Room Air to enter a room air 6-min walk test. A small
window asking you for the study date will appear. It will have today's date in it
(or whatever date is set on your workstation). Accept it. Now you should see an
empty 6-minute walk window as in the following screenshot.
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Enter a Patient ID of all zeros. The default format of the Patient ID is "7 digits - 1
digit" so "0000000-0" should work. If someone has modified the patient id format
for your site, enter a Patient ID of all zeros in your site's format. You will know
when the Patient ID format is accepted when you can no longer change it (eg.
delete any part of it).
After the Patient ID format is accepted, a window should be displayed asking you
if you are entering a new patient (ie. that patient was never entered before).
Click Yes to accept. A demographics window should now appear as seen in the
following screenshot:
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Enter some values. You must enter a minimum of Patient ID (all zeros!), Race,
First Name, Last Name, Sex and Birthdate for the OK button to be enabled. You
may enter some other data as well. When done, click OK to save your data
You should now be back in the 6-min walk window, but now some patient data
was already filled in, like patient's name and age. Now enter the following test
data:
Baseline Heart Rate: 80
Baseline O2 Saturation: 90
6 Minute Heart Rate: 100
6 Minute O2 Saturation: 77
6 Minute Walk Distance: 512
Height: 177
– 23 –
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Weight: 80
Max BORG: 3
You data window should now look similar to the following screenshot

Now you are now ready to save your data into the database. Click OK.
If you did not receive any errors, you should now be back on the main window
with your data safely on the database server. If you did receive any errors, please
go back to the input window (Press Cancel in the error to cancel the save
operation) and verify you have only entered the above data. Then attempt to
retry the save operation once more. If problems persist, please contact our
technical support.
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You now have entered a Room Air 6-min walk. For our second example, we will
enter a 6-min Walk where the patient receives 3 liters of oxygen per minute.
Click on Patients → 6-min Walk → Oxygen. When the study date window comes
up, just accept the current date like before. On the data entry screen, enter the
same 0 based Patient ID as before (in the default case, it will be "0000000-0").
When the patient ID is accepted (ie. the field will become read-only) you should
immediately notice one difference from before. The patient demographic data,
and some latest data were entered for you automatically based on the latest
records in the database. Height and Weight are now set to the values you set in
the earlier 6-min walk.
Now, let's enter some data! Please enter the following data in order. Yes, include
the obvious error.
Baseline Heart Rate: 100
Baseline O2 Saturation: 1000
6 Minute Heart Rate: 8
6 Minute O2 Saturation: 90
6 Minute Walk Distance: 692
Height: 177
Weight: 81
Max BORG: 2
Oxygen: 3
You probably noticed there is something funny in this data as seen in the
following screenshot
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When entering data, almost all of the numeric data entries you enter will have a
label with the units for this field. During data entry, this field can turn three
different colours. These colours based on the value entered and the settings of
that field in the preferences window. The meaning of these colours is as follows,
BLACK indicates the value is in range and should be accepted by the
database
● BLUE indicates the value is outside "normal" range but it is still a valid
entry.
● RED indicates the value is outside allowed data entry range. This could
indicate a data entry error.
Now, click OK to save the data. The data should be accepted by the database
●
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Assessment
Once again, you should now be located in the main window. Now, let's enter an
assessment by selecting Patients → Assessment from the main menu. A study
date window will now appear. Enter the date of July 15, 2002 and click on the OK
button. You are now in the assessment window. As always, let's first enter the
same Patient ID number we did for our 6-min walk exercises ("0000000-0"). As
soon as the Patient ID format is accepted, the Patient ID field will become read
only and the demographic information for our patient will be loaded from the
database. Also, since this is the first assessment in the database for this patient,
a window will pop-up asking you if the assessment you are entering should be
considered the first assessment that will be entered into the database.
Once you enter a "First Assessment", you will NOT be able to enter any
assessment data prior to study date of the "First Assessment". For example, if
you enter an assessment dated 2000-01-01 and specify that it should be
considered as a "First Assessment", you will not be able to enter an assessment
dated prior to 2000-01-01.
Let us assume we will enter the First Assessment for this patient and answer yes.
The "Initial Assessment" data tab will become editable - it is only editable for the
First Assessment. (definition: tabs are the little text labeled "buttons" used to
change your currently visible data entry page).
Data entry should be quite straight forward. Just a bunch of numbers and some
text. The only exception we did not get to is the Treatment page. Click on the
Treatment page. You should now see the following window:
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In the Treatment page, you will see the Medications control. All medication
changes are done with the controls on the right of the medication list. You enter
the medication on the top combobox, specify the daily dosage and the units of
the daily dosage, the drug route and when was the medication began. If you do
not know when the patient began his/her medication, leave the default Start Date
which will be the study date. We then click Add to add the medication. Please
note that dosage, units and drug route are optional entries.
In our example, let's write that our patient was on the following medications:
Medication Dosage
MED A
100 mg
MED B
1.232 mg
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In this example, start date should be the same as the date of the assessment.
After entering the data, the medication part should look like

Now, let's assume we made a little mistake. Our patient is actually on 101mg of
MED A, not 100mg. To correct this,
1. Click on MED A in the medication listing for the patient. The data we
entered should now appear on the right hand side.
2. Change 100mg to 101mg on the right hand side.
3. Click the Add button
What you should see now is that the dosage of MED A has been changed. This is
how you should modify dosage and drug route of a given medication. The
database will automatically alter the medication for the patient on the start date
of the new dosage and/or drug route.
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You will notice some control buttons other than Add in the medication control.
They mean:
•
•

•

Add - Adds medication or modifies drug route/dosage of a given medication
Stop - Indicates that a patient has stopped taking the drug on the study
date. The drug will be removed from the current medication list (current as
of the study date).
Del - This is a more dangerous cousin of the Stop function. This will
remove a given medication from patient history records completely.

There is only one reason to use the Del button and that is to correct spelling
errors associated with medication names. Let us assume that MED B is wrong.
There is no MED B. It should have been MED C. To correct this error, follow this
procedure exactly:
1. Add MED C medication with a 1.232 mg dosage (and the same start date
and drug route)
2. Click on MED B on the patient's medication list, and hit Del
MED B is now erased from our patient's medical records.
You should now have an idea how medication is added, modified, stopped and
even spelling mistakes corrected. Now, let's go on to the Secondary Diseases and
Allergies entry sections of the Treatment page. You should notice that they look
very similar to the Medications section and you will be correct. They work
exactly the same except there is no Dosage, Drug Route or Start Date. As an
exercise, add that our patient is Allergic to WATER.
At this point, please look through all of the data entry pages in the Assessment.
Now, click OK to save our first Assessment. You should be back on the main
screen.
Now, let's enter another assessment, this time dated 2003-01-01. Click on
Patients → Assessment and enter the study date of 2003-01-01. Now, enter the
zero only patient id as before and the patient demographics should be loaded. In
addition, go to the Treatment page. You will notice that the database has also
loaded our patient's medication and other data.
For this assessment, let us do the following things:
•
•

Stop MED C medication.
Enter 120 as the Na in the Lab page

Now click OK to save the new assessment. You should now be back in the main
window.

Follow-up
So far we have completed two 6-min walks and two assessments for our test
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patient. Before we enter a followup, let's explain the difference between a
followup and an assessment. In a nutshell, there is almost no difference between
a followup and an assessment except that a followup only has a subset of the
functionality of a full blown assessment. For example, if a patient visits a doctor
and only has his/her medication adjusted then that is a followup. On the other
hand, if the patient visits their doctor and has blood work or other tests
completed that are not part of a followup, then that is an assessment.
Now, let's go enter a followup for our test patient. Go to Patients→Followup.
For the study date, enter 2005-01-01 and click OK to proceed. You should now
see an empty followup window. Enter our all-zero Patient ID. You should now see
a followup window like the one in the following screenshot.

For our followup, let's just enter some symptoms that the patient has, nothing
else. Check the following symptoms and then click OK to save our followup.
•
•

Loud P2
Chest Pain

There is nothing new in the followup that we have not covered in the Assessment
section above.
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Vasodilator Challenge
By default, Vasodilator Challenge is empty and not configured. You will need to
configure the dosages and what tests you perform as directed in the Vasodilator
Challenge configuration section.
After Vasodilator Challenge is configured, you may enter its data by going from
the main window to Patients→Vasodilator Challenge and then specifying the
date of the test as the study date. When the window appears, enter the Patient ID
field first (as always). You will then be able to specify the drug and the data.
After data entry is completed, click on the OK button to save your test.

Editing Previously Entered Data
Now that we have entered some data, we may want to edit it. To edit patient data
go to Patients→List All to list all of your patients. A widow with all entered
patients will appear. Data is by default sorted by Patient ID. Now, locate the all
zero patient ID we have been using to enter our test patient data in the above
sections and click on the little plus sign [+] to view the complete list of the
records we have entered. It should look similar to the following screenshot
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To edit any of the given records, right click on it and select the edit function
specific to the test. For example, let's edit the 6-min walk data on Room Air.
Right click on the record and select "Edit 6-min Walk". A 6-min walk entry
window will appear with the patient data we have entered earlier. Now, change
the Baseline Heart Rate from 80 to 85 and click OK to save the data. You will be
back in the Patient List window with your modifications saved to the database.
You are now ready for the basic reports tutorial.
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Reports
There are two basic types of reports available in PHMS,
•
•

Individual Reports
Trends

Both of these reports are available directly from the Patient List window. Just to
repeat what what said in previous tutorial, to get the the Patient List window, go
to Patients→List All from the main window. Go there now. Locate our zero
based patient ID and expand their record (click the little [+] next to their patient
id).

Individual Reports
Individual reports are specific to each record type. For example, right click on
any of the patient's 6-min walks and select Preview Report from the popup menu.
Now close the report. Right click on an assessment and select Preview Report.
You should see a difference from the report for the 6-min walk.
For each of the record types you can preview a report and/or you can print it.

Trends
You should now be in the Patient List window and be looking at our zero-based
patient ID. Now, right click on a 6-min walk test and select 6-min Trend. A
window should popup that should look like the one in the following screenshot.
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This trend is a summary of all the 6-min walk tests entered for our patient. After
looking around the trend window, close it to go back to the Patient List window.
Another type of trend is the general trend. To access it, right click on our patient
and select Trend. This will popup a window that should look like the following
screenshot.
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This trend will list all of the numeric data from Assessments, Followups and 6min Walks. The data is listed in reverse-chronological order - the latest data on
the left and the oldest towards the right. Each column is dated with a single
letter in front of the date. The lettering refers from where all (or most) of the
data in that column came from (an Assessment, a Followup or a 6-min Walk). As
you can see, it is quite empty because we have not entered much data in this
tutorial.
An important function of this trend is that it will enable you to graph arbitrary
data. To graph data, simply select the rows you wish to graph just like on a
spreadsheet (select multiple rows by holding down Ctrl and clicking). Then press
graph to graph the data.
For the graph to be displayed, you will need to have at least two data points

Concluding Remarks
This concludes our short tutorial. You should now be able to enter data, edit it
and produce basic reports. There is only one thing to be done to conclude this
tutorial and that is to clean up the database from our test patient. Go the the
Cleanup section.
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Cleanup
To cleanup the database from our test patient, go to the Patient List window
(Patients → List All from the main window). Locate a Patient ID with all zeros. If
you cannot, then the test patient doesn't exist and you are done. If you can see a
test patient, right click on their Patient ID and select Delete. A confirmation
dialog box should appear asking you if you wish to remove the test patient. Click
Yes to confirm. The patient and all of its data in the database should now be
removed.
To confirm that the delete worked, reopen the Patient List window (close it and
open it again). You should not be able to find our test patient.
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Configuration
Most of the customizations for PHMS reside in the Preferences window
accessible from the Options menu. Virtually all of the preferences data is stored
in the database in the preferences table. The sole exception to this rule is the
Hospital ID while is stored in the registry key
HKEY_CURRENT_USER\Software\GalacticaSoftware\PHMS Database Client
Other options that are also stored at that registry key include window positioning
and sizes.
As most of preferences is stored in the database, any change in the preferences
will have global implications. That is, a change in the preferences will affect ALL
installations of PHMS at a given site. For these reasons, only database superuser
(postgres) may be able to affect these settings.
Reports are configured from the Options -> Reports menu.
•
•
•
•
•
•

General Options Tab
Field Types
Vasodilator Challenge (Response Tab)
Formulae
Advanced Options
Reports
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General Tab
The General tab in the Preferences dialog box represents all of the options that
cannot be grouped with other options found in this Window.

Summary
•

Hospital ID - a unique ID
that identifies a given site

•

Patient ID Format specifies the format of the
patient ID using Regular
Expressions
Patient ID Test - allows one
to test the patient ID format
changes before they are
committed site-wide
Site Template Path location where local
templates are stored
Printer Header - an HTML
header that is printed as
the #header# element of
Figure 3: General tab of the Preferences
each and every report
window

•

•

•

Hospital ID
Identifier for the hospital or installation site. Programs using different Hospital
IDs will not be permitted to share patient data, even if using the same database
server. Hospital ID is limited to 5 characters.

Pat ID Format
Patient ID format specifies the allowable form of any patient id using a regular
expression. Regular expressions are used extensively to describe match
conditions. PHMS uses regular expressions to evaluate whether or not a given
patient ID has an acceptable form. For example, during data entry, when a valid
patient ID is entered, PHMS will search the database for that given patient and
whether data for that patient may be entered.
Paraphrasing, regular expressions are a set of special characters that represent
either a group of symbols or the symbols themselves.
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Element

Meaning
Any character represents itself, unless it has a special meaning in
a
regular expressions. Therefore a matches the character a
Any special character that follows a backslash matches that character.
Therefore, \^ matches the ^ symbol. A list of special characters
\a
follows this table.
\t
Matches the TAB character
\d
Matches any digit
\D
Matches any non-digit
\s
Matches any whitespace
\S
Matches any non-whitespace
\w
Matches any word character
\W
Matches any non-word character
The following listing of special notation that is used to match a given set. If a
patient ID needs to match a special character, like {, that character must be
escaped as in \{.
Special
character

Meaning

.

Matches character
Matches any of the characters in the square brackets. For
[...]
example, [a\d] matches a character a or any digit character
Matches character a n-number of times. n is an integer and a can
a{n}
be any character or set of characters, including a set of
characters described by [...] brackets.
Matches the beginning of a string. If used inside the [..] brackets,
^
right after the opening first bracket, it negates the set. This
means [^abc] will match anything but a, b, or c.
If used in [...] set, matches a range of characters. For example, [47] matches 4, 5, 6, and 7 while [a-c], matches a, b, and c.
Matches 0 or 1 occurrence of character a.
a?
Matches 1 or more occurrences of character a.
a+
Matches 0 or more occurrences of character a.
a*
Matches the end of a regular expression.
$
(expr1|
Matches characters in either expression. For example, (test|mail|
room) will match test or mail or room.
expr2)
Some simple examples of regular expressions are:
Expression
^\d{7}-\d$

Meaning
matches 7 digits, followed by a - followed by another digit.
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^\d{5}$
^\d{2}\w{3}\d
$
^[A-F]{5}$

matches 5 digits
matches 2 digits, followed by 3 word characters, followed by 1
digit
matches five characters from set A,B,C,D,E or F.

Changing the format of the patient ID to a format that is not compatible with the
format of the previous patient ID used will prevent new data to be appended to
those affected patient IDs. For example, old assessments will be available for
edition, but it will not be possible to enter new assessments for affected patient
IDs.

Patient ID Test
This field enables one to test the Patient ID Format before a site-wide
deployment. The field label will be red when the test patient ID does not satisfy
the new Patient ID Format, and it will be black otherwise.

Site Template Path
This is the search path for all of the statistical and user templates. It will be
searched prior to the installation directory. This path may be a share path where
given templates are located. Even for single computer installations, if you choose
to alter or add new report templates, please put them in a separate folder and
specify the path here. The installation directory will be overwritten upon
software upgrades and you may lose your custom templates.
When specifying a remote share path, make sure that all of the computers
running PHMS may access that share. For example, if the template files are
located on a computer Computer1 and path template_path that is mapped to
drive Z: on your computer, you should specify the path as
\\Computer1\template_path instead of Z:\. The reason is not all of the computers
may have Computer1 path template_path mapped as drive Z:

Print Header
The print header replaces the #header# data field in all of the report templates
with its text. The contents of this field are up to you, but they are HTML enabled
allowing you to add some formatting. For example, to add the following the
following header to your reports,
Hospital ABC Inc.
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Respiratory Medicine
123 Evergreen Ave.
Happy Town, Manitoba R3T 1A1
tel. (555)555-5555
You write,
<b>Hospital ABC Inc.</b><br>
Respiratory Medicine<br>
23 Evergreen Ave.<br>
Happy Town, Manitoba R3T 1A1<br>
<i>tel.</i> (555)555-5555

Where <br> takes place of a line break. In HTML, Enter does not signify a line
break. Text enclosed between <i> and </i> gets marked italic and text enclosed
by <b> and <b> causes it to be displayed in bold lettering. For more in-depth
description of HTML consult your nearest HTML book, online tutorial or the
World Wide Web Consortium.
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Field Types
The Field Types tab of the
Preferences window is used to set
the data ranges, format and units
of any numeric data entry field in
the database.

Summary
•

•
•

•
•

Table Name & Field Name define the field for which
constraints are to be
defined
Field Units - units of a given
field
Normal Range - data within
this range can be
considered normal
Figure 4: Field types configuration panel
Absolute Range - data
entered outside of this range may be considered an input error
# of digits after decimal - specifies the precision of the data field
(Obsolete - No longer used by the software)

Table Name & Field Name
These two lists specify uniquely a field name in the database. Only numeric fields
may be found here as non-numeric fields do not have units or ranges associated
with them.

Field Units
Defines field units of a given field. These units are HTML enabled to allow more
precise formatting so mg/s<sup>2</sup> will result in mg/s2 being printed on
reports and used in the data entry windows.

Normal Range
Defines the normal data range for the given data field. Data entered within this
range will appear black in the data entry windows. Data entered outside of the
normal range, but within the absolute range will appear in blue.
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Absolute Range
Data entered outside of the absolute range will appear red in the data entry
window and may be considered an operator error.
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Vasodilator Challenge
This configuration tab is used to
define which tests and dosages
may be used during a vasodilator
challenge. The allowed dosages
must be a comma separated
list.All values must be numeric,
but do not need to be integers.
For example,
1, 1.5, 2.754
is allowed, but
1 mg, 2 mg
is not.
Changing allowed tests and/or
test dosages does not affect tests
that were already entered.
No tests will be allowed until
they are defined here.

Figure 5: Sample Vasolidator Challenge
configuration panel
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Formulae
Some parts of PHMS use specific
formulas to display some
information. Currently these
include the Ideal Body Weight
(IBW) as well as 6-min predicted
distance given age, height and
possibly weight. Almost any
operation may be specific using
normal operands. These include,
•
•
•
•
•

+ - Add
- - Subtract
* - Multiply
/ - Divide. Do not confuse
with \
Parenthesis ( )

Figure 6: Formula configuration panel
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Advanced Options
Advanced options tab contains
more advanced settings of
PHMS. These
should probably not be changed
without good reason.</p>
Using timestamps as study
date means that records will
have a DATE and TIME values
associated with them instead of
just a DATE. Please note that to
change this value, you will
require superuser privileges to
the database as most of the data
tables will require modifications
to accommodate the additional
TIME entry.

Figure 7: Default Advanced options tab
Additionally, when changing from
a DATE and TIME database back to a DATE only setup, none of the records must
share a date with another similar record. Failing that, the database will fail to
change its internal structures and will revert back to using DATE and TIME. An
error indicating a duplicate key error will be displayed.
Date Order indicates the order of the date entry fields. The default setting is to
use Day/Month/Year but any may be selected. Please note that this change, as all
others, is a site-wide change and all users of your database will be affected.
Date Print Format is used to setup the format of the printed date in reports.
Not all areas of the program will display the date in the given format. For
example, the Patient List window will always display the date in the ISO format
as that is the only format that allows sorting (eg. listing patient records in
chronological order).
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Reports
The reports that may be defined and
edited from the Preferences window
are only the statistical reports. The
report templates (the printouts) for
user and statistical reports are
defined in the Report Templates of
this manual.

Summary
•
•
•

New - adds new reports
Edit - edits the currently
selected report
SQL - displays the SQL
statement that is equivalent of
the selected report

SQL Display
NOTE: This should be used by
advanced users familiar with the
intricacies of SQL.
The SQL statement is the question
that the database server will
receive. The answer to this question
is then the report that will be
displayed to the user. Users familiar
with SQL may copy&paste this
statement, modify it and execute to
generate their own reports manually
from the database.

Figure 8: Statistical reports
configuration panel with some default
reports
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Custom Report Definition
After selecting New to create a
new report, or Edit to edit the
current selection, a window
displayed in figure below should
appear.

Name & ID
This should be a descriptive name
of a given report. In the above
example it is defined as "Number
of Female Patients" as that is
what this functions does. It
counts the number of patients
whose sex is Female.
The ID field defines the function
name that PHMS will search for
in its custom reports to replace
with the value of this function.
For example, to print the number
of female patients, specify
#fnumpat# in that report. This is a
more advanced function and does Figure 9: Custom Report configuration
window
not need to be defined if you do
not use custom report templates.

Operation, Operand & Conditions
The operation is what should be performed on a given field given a set of
conditions. In figure above, the function will count the number of records from
demographics.sex given the constraint that such a record belongs to Female
patient.
No matter what the operation is selected, the data that the operation will be
performed upon is always the latest available data for each patient.
The following is a summary of the available operations,
•
•

Count counts the number of records. This also effectively counts the
number of patients.
Average calculates the mean value
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•
•
•
•

Min fetches the minimum value of a record
Max fetches the maximum value of a record
Range retrieves the range and is analogous to specifying two reports, one
for Min and one for Max value
Histogram will create a histogram of the data instead of a numerical result

Each of the conditions (selection rules) for a given report has a number
associated with it. In the above example, the condition limits the count to only
the records where demographics.sex is Female and that condition has a number
1. Now, let's assume that you wish to count the number of Female patients that
have a WHO class of 3. You then need to click the [Add] button to add a
secondary condition and specify that lung_function.who_class = 3.
The data used in the report constitutes of the latest available patient data that
satisfies the supplied conditions.

Condition Order
Now you have a report that counts the number of Female patients with WHO
class of 3. Let's assume you with to count the number of Female patiets OR
number of patients with WHO class 3. This is where the Condition Order entry
field comes into play. The default joining action between separate condition
clauses is the AND statement which just means that all of the conditions must be
satisfied for a given piece of data to be used in the report. To specify the OR
condition between 1st and 2nd conditions, write 1 OR 2 in the Condition Order
field. If you wish, you may specify the AND statement in the Condition Order
field as well by writing 1 AND 2
You may add as many conditions as you wish and the Condition Order field can
be as complicated as needed. You may use parenthesis to help you specify the
evaluation order of more complicated conditions. For example, the following
conditions are all valid for queries with 4 or more conditions.
•
•
•
•

1 OR 2 OR 3 OR 4
1 OR (2 AND 3 AND 4)
(1 OR (2 OR (3 AND 4)))
1 OR 4

The last statement only contains the 1st and the 4th conditions, yet it is still
valid. The reason is the missing conditions will be appended with an AND so 1 OR
4 is equivalent to (1 OR 4) AND 2 AND 3
Specifying conditions that do not exist will result in invalid questions. For
example, if you have 2 conditions and write 1 OR 2 OR 3 in the Condition
Order field, the statement will be invalid and will produce no output.
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Relative Reports
Relative reports are just like regular reports except the resultant values are
relative to another report's results. For example, with a non-relative or an
absolute value report, you may ask,
•
•

How many patients are on medication A?
How many patients have WHO class III?

With a relative report, you may now ask “What is the fraction of patients on
medication A in WHO class III of patients as compared to the number of all WHO
class III patients?”
To ask a relative question, one must first define the absolute value part of the
question in a separate report (if it doesn't yet exist). In the above case, this
report will count the the number of patients in WHO class III.
After constructing the absolute report, to construct a relative report, set up the
report to ask the number of patients that are on medication A with WHO class of
III. Then from the drop down list, you may select the title of the report that
counts number of patients in WHO class III.
The reason why the relative report requires the medication condition as well as
the WHO class condition is because we are asking for the number of patients on
medication A in WHO class III relative to all the patients in WHO class III. If we
did not specify WHO class in the relative report, we would be asking for the
number of patients on medication A relative to all patients in WHO class III.
Stated more clearly, we want
# of Med A patients in WHO group III
number of WHO group III
and not
# of Med A patients
number of WHO group III
Relative reports may be relative to other relative reports. This may or may not be
useful!

Histograms
There are two types of histograms available. These are,
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•
•

Numeric histograms, and
Text histograms

Numeric Histograms
Numeric histograms are histograms
that bin numeric data fields, like Age or
Na lab results or 6-minute walk results.
Histogram Options window for these
types of fields is to the right. The
following options are available:
•

•

•

•

•

Minimum Bin Value, if not set to
auto, specifies the minimum value
of the first bin. Values from the
database below this threshold will
be ignored.
Maximum Bin Value, if not set to
auto, specifies the maximum
value of the last bin. Values from
the database greater than this
threshold will be ignored.
Number of Bins, if not set to auto,
specifies the number of bins that
the histogram should be divided
into. Any non-negative integer
value is permitted, but it is
recommended to keep this value
in the 5-15 range.
Bin Width, if not set to auto,
specifies the width of each of the
Figure 10: Numeric Histogram
bins.
Separate Genders, when checked, Options configuration window for the
6-minute Walk Distance histogram
will result in a histogram that is
split between Male/Female/Both.
If unchecked, only the Both bar will be present in the histogram

You cannot specify any combination of the above fields. For example, you cannot
specify Number of Bins at the same time you specify the Bin Width.
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Text Histograms
Text histograms are used to
match non-numeric fields.
This includes fields like
medication, ANA Pattern lab
results, and others. Unlike in
numeric histograms where
we need to specify binning
criteria based on numeric
data ranges, here we can
only specify distinct bins as
in the sample Treatment
histogram to the right.
To Add a text bin to the
histogram, locate the text in
the drop down list to the
right of the Add button. In
case of medication, if you
cannot find a given
medication's name, you may
enter it manually but please
note that all the medications
entered into the database are
in the drop down list. After a
given text criteria is found in Figure 11: Histogram Options configuration
window for the Treatment histogram
the list, click on it then click
on the Add button to add it
to the list. This will remove the item from the drop down list and insert it into
Matching Strings list (ie. the binning criteria of the histogram).
To delete a bin, or to move it from Matching Text back to the drop down list,
select it and then click the Del button
You may also use the Up and Dn buttons to move selected bins up and down in
the Matching Text list. The order of this list determines the order of the bins in
the histogram. The first item listed will be the left-most bin in the histogram
To specify a specific combination of Matching Text, select the two or more items
from the list and click the Com button. This will create a new bin that will be a
specific combination of the items. To specify an arbitrary combination, just check
the boxes in the Combinations field. For example, in the Treatment histogram in
Figure 11 above, Any 2 bin will match (BOSENTAN AND FLOLAN) OR
(BOSENTAN AND SILDENAFIL) OR (FLOLAN AND SILDENAFIL).
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Match ALL checkbox is a bin that is an equivalent of a combination of ALL the
items in the Matching Text.
Match None will match only if none of the bins in Matching Text match the
data. In our example in Figure 11, Match None will match all patients that are
not on BOSENTAN, FLOLAN or SILDENAFIL.
Exclusive Match is a very important option and needs to be understood to
successfully use text histogram feature. A number of data fields (all with
checkboxes and medications) can have more than one value. For example, a
patient can be on more than one medication. When Exclusive Match is checked,
data in the histogram is binned as follows:
•
•
•
•

If data matches one and only one of the bins in Matching Strings, it is then
added to that bin. Otherwise,
If data matches any of the Combinations as per checkboxes, then it is
added to that bin. Otherwise,
If data matches ALL of the of the Matching Strings and Match ALL is
selected, then it is added to that bin. Otherwise,
If Match None is selected, it is added to Others bin

If Exclusive Match is not-checked, then bin matches are not exclusive. For
example, patient on BOSENTAN and FLOLAN would be added to the first bin
and to the second bin in Figure 11 example. That patient would also be added to
the Any 2 combination bin and possibly to None bin if the patient was on other
medication than in Matching Text. So when is it right to have Exclusive Match
unchecked? For example, you wish a histogram of the number of patients that
had Chest Pains, that had Elevated JVP and had Loud P2 in their latest followup
symptoms. If you do not check Exclusive Match then a patient with Loud P2
and Chest Pains will be added to both bins in the histogram. Then the histogram
will represent number of patients that had
•
•
•

Chest Pains
Elevated JVP
Loud P2

If Exclusive Match is selected, the histogram will display all patients that
•
•
•

had Chest Pains, but didn't have Elevated JVP nor Loud P2,
all patients that had elevated JVP but no Chest Pains and no Loud P2 and
and all patients that had Loud P2 but no Chest Pains and not an Elevated
JVP

Whether or not you have Exclusive Match selected, the proper setting depends
on the nature of question you wish to ask.
As in the numeric histogram, Separate Genders, which checked, will split the
histogram based on gender.
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Data Entry
Data entry into PHMS database should be relatively straightforward. All of the
regular data entries for,
•
•
•
•

assessments,
followups,
vasodilator challenge, or
6-minute walk

are accessible from the Patients menu in the main window. Of course, there are
a few things to keep in mind which will be outlined below.
Data entries are relatively independent of each other with the exception that an
Assessment must precede either a Followup Report or Vasodilator Challenge.
For more information, please see the Tutorial

Medication/Allergy/Secondary Disease Data
Entry
When entering patient medication, secondary diseases or allergies, the Add,
Stop and Del buttons have the following meanings:
•
•

•

Add - Adds current item to the patient's "chart"
Stop - Indicates that the current item is stopped. For example, if a given
patient had an XYZ secondary disease this indicates that the patient was
cured as of this study.
Del - Indicates that addition of the item was a mistake and should be
deleted. For example, if a given patient had an XYZ secondary disease, this
indicates that the person actually never had it in the first place and its
entry onto the record was a clerical error.

Vasodilator Challenge
Vasodilator Challenge first requires that the tests used and dosages used are
configured in the Preferences window. Please see the configuration
documentation for further details.
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Statistical Error Checking
A statistical error checking tool is included under the Tools -> Error Check
menu. This tool will scan the database and attempt to locate any errors using a
statistical method.
To find errors, each numeric field is scanned. If it contains more than 10 data
points, a standard deviation is calculated of about the middle 75% of the
available data. Then the database is searched for any data that is more than 50
standard deviations away from the calculated mean.
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Reports
There are two types of reports available,
1. individual reports, and
2. statistical reports.
If you are looking to modify the format of individual or statistical reports, go to
the section Editing Reports.

Individual Reports
Reports for individual patients
are accessible from the Patient
List (Patients→List All from the
main menu). Each patient is
associated with multiple
records (Assessment,
Followup, Response and 6-min
Walk). Right clicking on any of
these will bring up a menu as
seen in the figure above.
Reports associated with that
particular record are
accessible by either the Print
Report or Preview Report
functions.
6-min walk trend is accessible
by right clicking on any 6-min
walk record and selecting 6min Trend.

Figure 12: Individual report access point in the
Patient List window
General trend is accessible by
right clicking on any of the
patient records, including his/her name and selecting Trend. The trend window
will appear where the value are listed in reverse chronological order - latest data
is on the left. The column are labeled with type of record data is coming from
and date of that record. The acronyms are A for Assessment, F for Followup and
W for 6-min walk.
Graphs may be generated of one or more data sets by selecting the rows you
wish to graph (hold down Ctrl or Shirt buttons to select more than one row) and
then clicking the Graph button.
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Statistical Reports
To access statistical reports, go
to the main window and select
Patients→Custom Report Su
mmary. A report window with
calculated numeric values will
appear as in the Figure 13 to
the right. All histograms are
accessible by right clicking on
their rows and selecting View
Histogram.
Each of the reports may have
conditions that limit the
number of patients that are
used in such reports. To list
these patients, right click on
report and select List
Patients. For example, the
count of the number of female
patients has a condition where
Figure 13: Sample statistical reports
demogprahics.sex must be
Female. Right clicking on the
Number of Female Patients report and selecting List Patients will list all of the
female patients.
Statistical Report generation and listing a large number can take a some time
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Appointment Management
Appointments are displayed in the opening main window. Highlighting an
appointment ad clicking the Go... button, or simply double-clicking on an
appointment entry, will open a data window for the patient. Right clicking on an
appointment allows for,
•
•
•
•

rescheduling a given appointment,
creating a new appointment for that patient,
canceling that appointment, or
entering data

Appointments window also incorporates an icon set that allows for easier
management. These icons include,
Icon

Meaning
An appointment is less than 30 minutes away or is overdue
The appointment is has been completed within the last 30 minutes.
The appointment has been canceled within the last 30 minutes
The appointment is overdue for over 30 minutes
After an appointment has been completed, it can be edited from the main
window for 30 minutes until after the appointment.
Appointments are updated from the central database every 30 seconds. This that
any additions or changes to a given appointment will be visible to everyone using
PHMS within 30 seconds.

– 59 –

Common Problems and Solutions

Common Problems and Solutions
The following is a list of common errors, problems and questions that may and/or
will arise during your use of the software. Please read them before contacting
support.

Where is File→Save? Where is the data saved?
Please read the Overview page of the installation section of this manual. Pay
attention to the diagrams. If need be, please consult your support department to
explain the concepts in more detail.
Please also read the tutorial

What is Patient ID?
Patient ID is a unique numeric identifier of a patient for your site. For
information how to set the format, please read the configuration section of this
manual
Please also read the tutorial

I'm entering assessment data, but can't click the OK
button to save
You've probably not entered all of the necessary demographics data. Items in
RED must be filled in and the Patient ID must of the correct format. Only then
will the OK button be available.

What is "Initial Assessment"?
Initial assessment is the first assessment of the patient. This is the first data
entry (chronologically by study date, not necessarily in data entry order) for the
patient's history. Please note that once you enter an Initial Assessment, you
cannot enter another assessment with the study date prior to that of the Initial
Assessment.
An initial assessment allows you to enter some additional patient data. For
example, Past Surgical History prior to the patient's arrival at your facility.
There is no requirement that you do enter an Initial Assessment.

– 60 –

Common Problems and Solutions

What is "study date"?
This is the date under which the data you are going to enter will be filed. You can
only have ONE assessment, ONE follow-up, ONE response, ONE oxygen 6-min
walk and ONE room-air 6-min walk per "study date" or "data date"

After I entered data and pressed OK I get an error "The
database operation failed with the following error:....
duplicate key violates unique constraint....". What is
wrong?
You cannot enter the same patient test for the same day. There can only be one
patient type of data saved per patient per date. That is, there can only by one
assessment, one followup, one vasodilator challenge, one oxygen 6-min walk and
one room air 6-min walk for a single study date.

After I entered data and pressed OK I get an error "The
database operation failed with the following error:....
numeric field overflow....". What is wrong?
Upgrade to version 1.1.13 or later.

My database computer died! All my data is gone!
Database got corrupted! Help!
Please read the Backup & Restore section of this manual for instructions on how
to restore from backup. If you have not setup backups for your database, we
cannot help you.

I REALLY think I found an error in the program. How can
I get it fixed?
Please send the error condition with any error messages to the support email
address. If possible, please describe ALL the steps needed to duplicate the
problem. If we cannot duplicate the problem, we are less likely to be able to find
it and fix it.
If we determine the problem is caused by our software and are able to reproduce
it in our facility, we will provide you with an updated version in a timely fashion.
Furthermore, if you do notice errors, even small spelling errors in error
messages, please report them such that they can be fixed and the program be
better for everyone.
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